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User Manual of CMS

Thank you for purchasing our product. If there is any question or request, please do not hesitate to
contact the dealer.

This manual applies to CMS.

This manual may contain several technically inaccurate points or printing errors, and the content is
subject to change without notice. The updates will be added into the new version of this manual. We

will readily improve or update the products or procedures described in the manual.
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Chapter 1 Overview

1.1 Description

CMS is a versatile video management software for the DVRs, NVRs, IP cameras, encoders, decoders,
etc. It provides multiple functionalities, including real-time live view, video recording, remote search
and playback, file backup, etc., for the connected devices to meet the needs of monitoring task. With
the flexible distributed structure and easy-to-use operations, the client software is widely applied to
the surveillance projects of medium or small scale.

This user manual describes the function, configuration and operation steps of CMS software. To
ensure the properness of usage and stability of the software, please refer to the contents below and

read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows
2003/Windows XP(32-bit operating system)

CPU: Intel Pentium IV 3.0 GHz or above

Memory: 1G or above

Display: 1024*768 or above

=

®  For high stability and good performance, these above system requirements must be met.
® The software does not support 64-bit operating system; the above mentioned 64-bit operating

system refers to the system which supports 32-bit applications as well.

1.3 Function Modules

Control Panel of CMS:
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Network0% CPU:0% Memory:6% root 19:3519 '@ - B8 %

Operation and Control

@ ud -

Main View

Remote Playb... E-map

Maintenance and Management

DR \

Device Manag...

Event Manage...

(] :
.Q.f:— ahdn J\ \E\

Record Sched... Account Mana... Log Search System Config...

Menu Bar:
Open Captured picture Search and view the captured pictures stored on local PC.
. Open Video File Search and view the video files recorded on local PC.
File Open Log File View the backup log files.
Exit Exit the CMS software.
Lock Lock screen operations. Log in the client again to unlock.
System Switch User Switch the login user.

Import System Config File Import client configuration file from your computer.

Export System Config File Export client configuration file to your computer.
1024*768 Display the window at size of 1024*768 pixels.
1280*%1024 Display the window at size of 1280*1024 pixels.
1440*%900 Display the window at size of 1440*900 pixels.
1680*1050 Display the window at size of 1680*1050 pixels.

— Full Screen Display the window in full screen.
Control Panel Enter Control Panel interface.
Main View Open Main View page.
Remote Playback Open Remote Playback page.
E-map Open E-map page.
Auxiliary Screen Preview Open Auxiliary Screen Preview window.
Device Management Open the Device Management page.
Event Management Open the Event Management page.
Record Schedule Open the Record Schedule page.
ool Account Management Open the Account Management page.
Log Search Open the Log Search page.
System Configuration Open the System Configuration page.




User Manual of CMS

Help

Broadcast Select device to start broadcasting.
Device Arming Control Set the arming status of devices.
1/0 Control Turn on/off the alarm output.
Player Open the player to play the video files.
Message Queue Display the information of Email message to be sent.
Open Wizard Open the guide for the client configuration.

User Manual (F1) )
Manual by pressing F1 on your keyboard.

Click to open the User Manual; you can also open the User

About View the basic information of the client software.

Language . .
software to activate the settings.

The CMS software is composed of the following function modules:

@
«d

B> e

r' A/
-i.

The Main View module provides live view of network cameras and video encoders, and

supports some basic operations, such as picture capturing, recording, PTZ control, etc.
The Remote Playback module provides the search, playback, export of record files.

The E-map module provides the displaying and management of E-maps, alarm inputs, hot
regions and hot spots.

The Device Management module provides the adding, modifying and deleting of different
devices and the devices can be imported into groups for management.

The Event Management module provides the settings of arming schedule, alarm linkage

actions and other parameters for different events.
The Record Schedule module provides the schedule settings for recording.

The Account Management module provides the adding, modifying and deleting of user
accounts and different permissions can be assigned for different users.

The Log Search module provides the query of system log files and the log files can be
filtered by different types.

The System Configuration module provides the configuration of general parameters, file

saving paths, alarm sounds and other system settings.

Click the icon D in the upper-left corner of the interface to show the Menu List.

The function modules can be easily accessed by clicking the navigation buttons on the control panel or

by selecting the function module name from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage and

time, at the top of the main page.

Select the language for the client software and reboot the
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Chapter 2 Live View

2.1 User Registration and Login

For the first time to use CMS software, you need to register a super user for login.

Steps:

1. Input the super user name and password.

2. Confirm the password.

3. Optionally, check the checkbox Enable Auto-login to log in the software automatically.
4. Click Register. Then, you can log in the software as the super user.

Register Administrator x

Please create a super user before proceeding

Super User: il
Password:
Confirm Password:

Enable Auto-login

Register | Cancel

s

® A user name cannot contain any of the following characters: /\: *? “<> |
® The password cannot be empty and the length of the password should be no less than six

characters.

When opening CMS after registration, you can log in the client software with the registered user name
and password.

Steps:

1. Inputthe user name and password you registered.

2. Optionally, check the checkbox Enable Auto-login to log in the software automatically.

3. Click Login.

User Mame: root e

Password:

Enable Auto-login

Login Cancel

After running the client software, a wizard will pop up to guide you to add the device and do some

basic settings.
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2.2 Adding the Encoding Device

Purpose:

After running the CMS, devices including network cameras, video encoders, DVRs, NVRs, should be
added to the client for the remote configuration and management, such as live view, playback, alarm
settings, etc.

Perform the following steps to enter the Encoding Device Adding interface:

1. Clickthe M icon on the control panel,
or click Tools->Device Management to open the Device Management page.
Click the Server tab.

3. Click Encoding Device to enter Encoding Device Adding interface.

= Server - Group
Organization Device for Management (0)
_ Add Device Modify Delete Remote Config Refrash All Filter
Add New Device Type Mickname = |IP Device Serial No. Met Status HDD Status Re

Online Device (2) Refresh Every 155

Add to Client Add All Modify Metinfo Restore Default Password Filter
IP 4 | Device Type Port Device Serial Mo Added
172.6.23.64 HU-XHHKHKH-K X 2000 KX X-XX 1620111128BBRR4068009820WCVU  No
172.6.23.177 KR HOOOK- XK 8000 HH-XNKXK-XX0120130121CCRR416 186816 Mo

Encoding device can be added
DVR/DWS/MVR/IPCAPDICMS
PCNVRICMS Encoding Server

You can add the device in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.
® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

® By SIMPLEDDNS, see Section 2.2.5 Adding Devices by SIMPLEDDNS.

2.2.1 Adding Online Devices

Purpose:
The active online devices in the same local subnet with the client software will be displayed on a list.

You can click the Refresh Every 15s button to refresh the information of the online devices.
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Steps:
1. Select the devices to be added from the list.
2. Click Add to Client to open the device adding dialog box.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

You can also click-and-drag the online device to Device for Management area to add the device.

Adding Mode:

2 IPiDomain IP Segment IP Server SIMPLEDDNS

Add Offline Device

Mickname:

Address:
Port: 3000

User Name:

Password:

-/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Cancel

Click Add All, input the user name and password, and you can add all the online devices to the client

software.

Select the device from the list, click Modify Netinfo, and then you can modify the network

information of the selected device.

Select the device from the list, click Restore Default Password, and input the security code. Then you

can restore the default password of the selected device.

2.2.2 Adding Devices Manually

Steps:

1. Click Add Device to open the device adding dialog box.
2. Select IP/Domain as the adding mode.

3. Input the required information.

Nickname: Edit a name for the device as you want.



User Manual of CMS

Address: Input the device’s IP address or domain name.

Port: Input the device port number. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password. By default, the password is 12345.

Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
Click Add to add the device.

Adding Mode:

@ IF/Domain IP Segment IP Server SIMPLEDDNS

Add Offline Device

Nickname:

Address:
Port: 8000

User Name:

Password:

 Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

2.2.3 Adding Devices by IP Segment

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Segment as the adding mode.
3. Input the required information.
Start IP: Input a start IP address.
End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add, and the device of which the IP address is between the start IP and end IP will be added

to the device list.

10
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Adding Mode

IPiDomain @/ IP Segment IP Server SIMPLEDDNS

Add Offline Davice

Start IP:

End IP:
Part: 8000
User Name

Password,
-/ Exportto Group
Create group with device IP.

2.2.4 Adding Devices by IP Server

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Server as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP Server address.
Device ID: Input the device ID registered on the IP server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

IP/Domain IP Segment @ P Server SIMPLEDDNS

Add Offline Device

Mickname:

Semver Address:
Device ID:
User Name:

Password:
-~ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

11
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2.2.5 Adding Devices by SIMPLEDDNS

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select SIMPLEDDNS as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.

Server Address: www.simpleddns.com.

Device Domain Name: Input the device domain name registered on SIMPLEDDNS server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
channels and alarm inputs of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

IPiDomain IP Segment IP Server # SIMPLEDDNS

Add Offline Device

Mickname:

Server Address: www.simpleddns.com
Device Domain Name:

User Name:

Password:

-/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

5=
CMS also provides a method to add the offline devices. Check the checkbox Add Offline Device,
input the required information and the device channel count, and then click Add. When the

offline device comes online, the software will connect it automatically.

The devices will be displayed on the device list for management after added successfully. You can
check the resource usage, HDD status, recording status, and other information of the added devices
on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in
the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of
the selected device.

Select device from the list, click Remote Config, and then you can do some remote configurations of

the selected device if needed.

12
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2.3 Group Management

Purpose:

The devices added can be organized into groups for a convenient management. You can get the live
video, play back the record files, and do other operations of the device through the group.

Before you start:

Devices need to be added to the client software for group management.

Perform the following steps to enter the Group Management interface:
1. Open the Device Management page.

2. Click the Group tab to enter the Group Management interface.

= Server - Group

_4AddGroup 5 Delete Group

Search. . Import Modify Dslste Remote Config Filter

Nickname - | Device Serial No.

Adding the Group

Steps:
1. Click Add Group to open the Add Group dialog box.
2. Input a group name as you want.
3. Click OK to add the new group to the group list.
You can also check the checkbox Create Group by Device Name to create the new group by the

name of the selected device.

Add Group

Group Name:

Create Group by Device Mame

Importing Encoding Device to Group

13
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Steps:
1.

Click Import on Group Management interface, and then click the Encoding Channel tab to open

the Import Encoding Channel page.

2. Select the thumbnails/names of the encoding channels in the thumbnail/list view.
Select a group from the group list.
4. Click Import to import the selected encoding channels to the group.
You can also click Import All to import all the encoding channels to a selected group.
£
[NoTE
® You can also click the icon on the Import Encoding Channel page to add a new group.
® Up to 64 cameras can be added to one group.

W Encoding Channel s Alarm Input

Select Device Al

Encoding Channel =[5 (2 Group

IPC1 LAJEC ]
IPC1-Encoding Channel
. + 3 NVR-Encoding Ghannel
L
IPC2-Encoding Channel
DVR-Encoding Channel
IPC2 ?[@)(2
— T
ﬂ Import
NVR L JIEIE

Importall

1) (2] (3] (4] 5] (8

The following buttons are available on the Import Encoding Channel page:

H==

=[5
O

@

4

A
s

List View View the encoding channel in list view.

Thumbnail View View the encoding channel in thumbnail view.

Refresh Refresh the latest information of added encoding channels.
Import Create a group by device name and import the device to group.
¥ Collapse/Expand Collapse/Expand the thumbnails of encoding channels.

Modifying the Group/Channel

Steps:
1.

2.
3.
4

Select the group/channel from the group list on the Import Encoding Channel page.

Click =", or double-click the group/channel name to open Modify Group/Camera dialog box.

Edit the group/channel information, including the group/camera name, the camera type, etc.
Click OK to save the new settings.

You can also double-click the group/channel name on the Group Management interface to open

the Modify Group/Camera dialog box.

14
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Modify Camera x

Mame: [IPC1_Camera1| ]
Camera Type: Main Stream | ~
Protocol Type: TCP | o
Modify Group
[iPc Copy to...

Removing Channels from the Group

Steps:
1. Select the channel from the group list on the Import Encoding Channel page.

2. Click ' toremove the channel from the group.
You can also select the channel on the Group Management interface, and then click Delete to

remove the channel from the group.

Select the group from the group list on the Import Encoding Channel page, and Click . You can
remove all the channels from the group.

Deleting the Group

Steps:
1. Select the group on the Group Management interface

2. Click Delete Group or click the icon " and the selected group will be deleted.

2.4 Basic Operations in Live View

Purpose:

For the surveillance task, you can view the live video of the added network cameras and video
encoders on the Main View page. And some basic operations are supported, including picture
capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

Click the @

or click View->Main View to open the Main View page.

icon on the control panel,

15
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View

Search

[ ——
1 LI 1-ereen ‘ ‘
[ 4-Screen T 4
Camera v
Search
2 + I NVR ‘ ‘
+ S5 1Pc2 l
PTZ Control v
3 v (la|l=|l+ &=
« || > + M -
v P + @ -
| —
=B @
Preset | Patem | Patrol

K ©

Presett

S

2 Preset2 ‘ ‘
03 Preset3
04 Presetd

05 Preset5

Main View Page
1 View List
2 Camera List
3 PTZ Control Panel
4 Display Window of Live View

5 Live View Toolbar

Camera Status:

@ The camerais online and works properly.
@ Thecameraisin live view.

gs The cameraisin recording status.

¢  The camera is offline.

Live View Toolbar:

IR e
On the Main View page, the following toolbar buttons are available:

Set the screen layout mode and save the new settings for the

E» Set View . ) .
current view; save the current view as another new view.

L} Stop Live View Stop the live view of all cameras.
t Previous Go for live view of the previous page.
= Next Go for live view of the next page.

Resume/Pause ) S
L2 I o . Click to resume/pause the auto-switch in live view.
7 Auto-switch
[ Show /Hide the Menu  Show/Hide the config menu of auto-switch. Click again to hide.
42 &8 Mute/Audio On Turn off/on the audio in live view
E Full Screen Display the live view in full screen mode. Press ESC to exit.

16
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Right-click on the display window in live view to open the Live View Management Menu:

B Stop Live View

I Capture

= Print Captured Picture

&= Send Email

BS startRecording

<> Open Window PTZ Control

@, Open Digital Zoom

% Switch to Instant Playback #

Start Two-way Audio
g Enable Audio

€ Camera Status
= Remote Configuration
=/ Synchronization

22 Full Screen

The following buttons are available on the right-click Live View Management Menu:

A 2 & & 1l Wgln

HEE

£

&=

g

Stop Live View
Capture
Print Captured Picture

Send Email

Start/Stop Recording
Open Window PTZ
Control

Open Digital Zoom
Switch to Instant
Playback

Start/Stop Two-way
Audio
Enable/Disable Audio

Camera Status

Remote Configuration
Synchronization

Full Screen

Stop the live view in the display window.

Capture the picture in the live view process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification to
one or more receivers. The captured picture can be attached.
Start/Stop the manual recording. The record file is stored in the PC.
Enable PTZ control function on the display window. Click again to
disable the function.

Enable the digital zoom function. Click again to disable the function.

Switch to instant playback mode.

Click to start/stop the two-way audio of the camera in live view.

Click to enable/disable the audio in live view.

Display the status of the camera in live view, including the recording
status, signal status, connection number, etc.

Open the remote configuration page of the camera in live view.

Sync the camera in live view with the PC running the client software.

Display the live view in full screen mode. Click the icon again to exit.

2.4.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:

1.
2.

Open the Main View page.

Optionally, click the = icon in live view toolbar, then click the screen layout button@‘ and
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select the screen layout mode for live view.
3. Click-and-drag the camera to the display window,

or double-click the camera name after selecting the display window to start the live view.

(nord

You can click-and-drag the video of the camera in live view to another display window if needed.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,

or double-click the group name to start the live view.

(nord

The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:

The video of the added cameras can be displayed in different view modes. 4 frequently-used default
view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Steps:

1. Open the Main View page.

2. Click theicon '* to expand the default view list.

3. Click to select the default view mode, and the video of the added cameras will be displayed in a

sequence in the selected view.

[NoTE

Right-click the current default view name on the list and click Save View As., and you can save

the default view as a custom view.

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.

Steps:

1. Openthe Main View page.

2. Click theicon * to expand the custom view list.

3. Click New View in the custom view list to create a new view.

4. Input the view name and click Add. The new view is of 4-Screen mode by default.

5. Optionally, Click the B icon in live view toolbar, then click the screen layout button EE- and
select the screen layout mode for the new view.

6. Click-and-drag the camera/group to the display window,
or double-click the camera/group name in custom view mode to start the live view.

7. Click the icon k& to save the new view.
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Right-click the custom view name on the list, and a menu pops up as follows:

= EditView Name
Iii Delete View
= Save View

&6 Save ViewAs.

The following buttons are available on the right-click menu:

Edit View Name Edit the name of the custom view.

] Delete View Delete the custom view.

d Save View Save the new settings of the custom view.

& Save View As. Save the current view as another custom view.

Stopping the Live View

Steps:

1. Select the display window.

2. Click the icon . that appears in the upper-right corner when the mouse pointer is over the
display window,
or click Stop Live View on the right-click menu to stop the live view of the display window.

You can also click the button in live view toolbar to stop all the live view.

2.4.2 Auto-switch in Live View

Camera Auto-switch

Purpose:

The video stream of the cameras from the same group will switch automatically in a selected display
window in camera auto-switch.

Steps:

1. Open the Main View page.

2. Select a display window for camera auto-switch.

3. Click theicon & in the toolbar and select the switching interval.

4. Select a group and click the icon 2 onthe group node.
5

You can click the icon C.‘./'O in the live view toolbar to pause/resume the camera auto-switch.
Single View Auto-switch

Purpose:

The video of all the cameras on the camera list will switch automatically in a selected default view in
single view auto-switch.

Steps:

1. Open the Main View page.

2. Click theicon & in the toolbar and select the switching interval.

3. Select a default view and click the icon ¥ on the selected view node.

4

You can click the icon C.‘./'O to pause/resume the single view auto-switch.
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Multi-view Auto-switch

Purpose:

The custom views will switch automatically in multi-view auto-switch. The custom views need to be
added before proceeding.

Steps:

1. Open the Main View page.

-

2. Click the icon in the toolbar and select the switching interval.
3. Clicktheicon 2 on the custom view node.
4

You can click the icon C.‘./O to pause/resume the multi-view auto-switch.

2.4.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset,
patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ

control for the operations of PTZ cameras.
Click theicon “ to expand the PTZ Control panel.

PTZ Control v

=B e W I
Preset Pattern Patrol

| R i

01 Presett
02 Preset2 | ‘
03  Preset3 1
04 Presetd

05 Presets

The following buttons are available on the PTZ Control panel:

Q Zoom

r Focus

() Iris

L Auxiliary Focus
3D Positioning

| ] Light

2 2 Wiper

g Lens Initialization

Configuring the Preset
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A preset is a predefined image position which contains information of pan, tilt, focus and other
parameters.

Perform the following steps to add a preset:

1. Click the Preset button to enter the PTZ preset configuration panel.

Click the direction buttons on the PTZ control panel to steer the camera to the desired view.

Select a PTZ preset number from the preset list and click .
Input the name of the preset in the pop-up dialog box.

vk w N

Click OK to save the settings.

To call a configured preset, double-click the preset, or select the preset and click the icon -
To modify a configured preset, select the preset from the list and click the icon .
To delete a configured preset, select the preset from the list and click the icon ﬂ

PTZ Control v

=B e @

| F’resei ] Pattern Patrol

01 Preset! 3

02 Preset2 ‘J

03 Preset3

Add Preset

04 Presetd

Configuring the Pattern

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Perform the following steps to add a pattern:
1. Click the Pattern button to enter the PTZ pattern configuration panel.

Click - to start recording of this pattern path.
Use the direction buttons to control the PTZ movement.

Click B to stop and save the pattern recording.
Click the icon - to call the pattern. To stop calling the pattern, click !

e

Only one pattern can be configured, and the newly-defined pattern will overwrite the previous

vk wnn

one.
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PTZ Control v

EE e @

Preset Paneg} Patral
"8

Configuring the Patrol

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable.

Before you start:

Two or more presets for one PTZ camera need to be added.

Perform the following steps to add and call a patrol:

Click the Patrol button to enter the PTZ patrol configuration panel.

Select a track number from the drop-down list.

Click == to add a preset, and set the dwell time and patrol speed for the preset.

Repeat the above operation to add other presets to the patrol.

Optionally, you can click A or o to edit or delete a preset in the patrol path.

o v Mw N e

Click the icon > to call the patrol. To stop calling the patrol, click —}

OkE

NOTE

—

® Up to 16 patrols can be configured.

® The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.

22



User Manual of CMS

PTZ Control v

| ___
Preset Pattern | F'atroll
5 Preset Presetd -
Dwell Time(s): (1 -
Patrol Speed: 1 s

2.4.4 Manual Recording and Capture

Toolbar in Each Live View Display Window:

In each live view display window, the following toolbar buttons are available:

Capture Capture the picture in the live view process.

- H Start/Stop Recording  Start/Stop manual recording. The record file is stored in the PC.
Switch to Instant

Switch to the instant playback mode.
Playback

Manual Recording in Live View

Purpose:

Manual Recording function allows you to record the live video on the Main View page manually and

the record files are stored in the local PC.

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click - in the toolbar of the display window or on the right-click Live View Management Menu
to start the manual recording. The icon - turns to H

3. Click the icon H to stop the manual recording.
A prompt box with the saving path of the video files you just recorded will pop up if all the

operations succeed.

.

® During the manual recording, an indicator E appears in the upper-right corner of the display
window.

® The saving path of video files can be set on the System Configuration interface. For details, see
Section 7.2.2 File Saving Path Settings.
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Viewing Local Record Files

Steps:

1.

2
3.
4

Click File->Open Video File to open the Record Files page.

Select the camera to be searched from the Camera Group list.

Click the icon E to specify the start time and end time for the search.

Click Search. The video files recorded between the start time and end time will be displayed.
Select the video file, and click Delete. You can delete the video file.

Select the video file, and click Email Linkage. You can send an Email notification with the selected
video file attached.

Select the video file, and click Save as. You can save a new copy of the video file.

Nore|

To send an Email notification, the Email settings need to be configured before proceeding. For
details, see Section 7.2.5 Email Settings.

Browse Record Files x
Camera Group Video Files @ Delete | [ Email Linkage(Max=5MB)| =B Saveas |

Search bl

= & IPc1

i

+ J NVR

4 IPC2

4/ \J DVR

Start Time:
2013-06-27 00:00:00 B
End Time:
2013-06-27 23:59:59 m

Q search

Double-click the video file and the video file can be played back locally.

@

00:00:07/00:12:30
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The following buttons are available on the local playback page:

B B0 crF/acrF Display the video in cif/4cif resolution.

E Full Screen Display the local playback page in full screen mode.
Close Close the local playback page of the record files.

Ll Bey| Pause/Play Pause/Start the playback of the record files.

| " Stop Stop the playback of the record files.

[ 1x | Speed Set the playback speed.

[ Single Frame Play back the record files frame by frame.

[ Digital Zoom Enable the digital zoom function. Click again to disable.
[a| Lul Enable/Disable Audio  Click to enable/disable the audio in the local playback.
R Capture Capture the picture in the playback process.

Capturing Picture in Live View

Steps:

1.

N

Move the mouse pointer to the display window in live view to show the toolbar.

Click the icon in the toolbar of the display window or on the right-click Live View
Management Menu.

A small window of the captured picture will be displayed to notify whether the capturing

operation is done or not.

=

The saving path of the captured pictures can be set on the System Configuration interface. For

details, see Section 7.2.2 File Saving Path Settings.

Viewing Captured Pictures

The pictures captured in live view are stored in the PC running the software. You can view the

captured pictures if needed.

Steps:

1.

vk W

Click File->Open Captured Picture to open the Captured Picture page.

Select the camera to be searched from the Camera Group list.

Click the icon [t to specify the start time and end time for the search.

Click Search. The pictures captured between the start time and end time will be displayed.
Double-click the captured picture to enlarge it for a better view.

Select the captured picture, and click Print. You can print the selected picture.

Select the captured picture, and click Delete. You can delete the selected picture.

Select the captured picture, and click Email Linkage. You can send an Email notification with the
selected picture attached.

Select the captured picture, and click Save as. You can save a new copy of the selected picture.
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Camera Group Local Capture = Print € Delete | [ Email Linkage(Max=5MB) | = Saveas
Search. P
= S IPci

@ IPC1_Camera1

- JIPC2

4 I DVR

Start Time.
2013-05-08 00:00:00 [
End Time

2013-05-09 23.59.59 ﬂ

Q, search

2.4.5 Instant Playback

Purpose:
The record files can be played back instantly on the Main View page. Instant playback shows a passage
of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an
immediate review if needed.
Before you start:
The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on
the DVRs, NVRs, Network Cameras, etc., or on the storage servers.
Steps:
1. Start the live view and move the mouse pointer to the display window to show the toolbar.
2. Click the icon in the toolbar and a list of time periods pops up.
30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.
3. Select a time period to start the instant playback.
Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant

playback will start from 09:27:00.
4. Click theicon again to stop the instant playback and go back for the live view.

=
® During the instant playback, an indicator appears in the upper-right corner of the display
window.

® The live view process will continue after the instant playback completed.
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Right-click on the display window to open the Instant Playback Management Menu:

Il Pause

W Sitop

M SpeedUp

44 SpeedDown

I+ Single Frame

@, Open Digital Zoom

Lis Capture

= Print Captured Picture
57 Send Email

B StartRecording

ly2 Enable Audio

% Switch to Live View

Full Screen

The following buttons are available on the right-click Instant Playback Management Menu:

EEEC& AN MalRPF¥ T

4

Iy

Pause/Play

Stop

Speed Up/Down
Single Frame

Open Digital Zoom
Capture

Print Captured Picture

Send Email

Start/Stop Recording
Enable/Disable Audio
Switch to Live View

Full Screen

Pause/Start the instant playback in the display window.

Stop the instant playback and return to the live view mode.
Increase/Decrease the play speed of the instant playback.

Play back the record file frame by frame.

Enable the digital zoom function. Click again to disable the function.
Capture the picture in the instant playback process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification to
one or more receivers. The captured picture can be attached.
Start/Stop clipping the record files.

Click to turn on/off the audio in instant playback.

Switch to live view mode.

Display the instant playback in full screen mode. Click again to exit.
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2.4.6 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio,

camera status and synchronization.

Aucxiliary Screen Preview

The live video can be displayed on different auxiliary screens for the convenient preview of multiple

monitoring scenes. Up to 3 auxiliary screens are supported.

Digital Zoom

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the

rectangle area will zoom in/out.

Two-way Audio

Two-way audio function enables the voice talk of the camera. You can get not only the live video but
also the real-time audio from the camera. This two-way audio can be used for only one camera at one

time.

Camera Status

The camera status, such as recording status, signal status, connection number, etc., can be detected

and displayed for check. The status information refreshes every 10 seconds.

Synchronization

The synchronization function provides a way to synchronize the live video clock with the PC which

runs the client software.
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Chapter 3 Remote Record Schedule Settings
and Playback

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
remote storage server connected, you can set the record schedule for the cameras for the continuous,
alarm triggered or command triggered recording. And the record files can be searched for the remote

playback.

3.1 Remote Recording

Purpose:
The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the

storage server connected.

Click the k‘ icon on the control panel,

or click Tool->Record Schedule to open the Record Schedule page.

Camera Group Record Schedule Copyto I save
Search
Lacal Recording
IPC1-Encoding Channel

-/ Record Schedule: All-day Template - Edit Advanced Settings
NVR-Enceding Channel
 Capture Schedule: Template 01 v Edit Advanced Settings
IPC2-Encoding Channel

- _I DVR-Encoding Channel

& DVR_Camera2

@ DVR_Camera3 All-day Template

@ DVR_Camerad.
& DVR_Cameras
@ DVR_Camera
@ DVR_Camera?
& DVR_Camera
@ DVR_Camerad
& DVR_Camera10
& DVR_Cameratt
@ DVR_Cameraiz
& DVR_Camera13
@ DVR_Camerat4
@ DVR_Camerais
& DVR_Camerais
@ DVR_IP Camerat

& DVR_IP Camera12

3.1.1 Recording on Storage Devices on the DVRs, NVRs, or

Network Cameras

Purpose:
Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as
the HDDs, Net HDDs and SD/SDHC cards for record files. You can set a record schedule or capture

schedule for the channels of the local devices.
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The pictures captured through the capture schedule are stored on the local device and can be
searched on the remote configuration page of the device.
Before you start:
The newly installed storage devices need to be formatted. Go to the remote configuration page of the
device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the
selected storage device.
Steps:
1. Open the Record Schedule page.
2. Select the camera in the Camera Group list.
3. Check the checkbox Record Schedule under Local Recording to enable device local recording.
4. Select the record schedule template from the drop-down list.
All-day Template: for all-day continuous recording.
Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
Alarm Template: for motion detection or alarm input triggered recording.
Template 01-08: fixed templates for specific schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Record Schedule Template.
5. Click Advanced Settings to set the recording parameters. For details, see Table 3-1 Advanced
Recording Settings.
6. Optionally, click Copy to... to copy the record schedule settings to other channels.

Click Save to save the settings.

Advanced Settings x

Pre-record: 55 -
Postrecord: 55 v
Video Expired Time: 0 day(s)
Redundant Record: Mo -
Record Audio: Yes -

Table 3-1 Advanced Recording Settings

Parameters Descriptions

Normally used for the event triggered record, when you want to record before
Pre-record

the event happens
Post-record After the event finished, the video can also be recorded for a certain time.

. . . The time for keeping the record files in the storage device, once exceeded, the
Video Expired Time
files will be deleted. The files will be saved permanently if the value is set as 0.

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD.

Record Audio Record the video files with audio or not.
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Configuring Record Schedule Template

Perform the following steps to configure the record schedule template:

If Template 01-08 is selected from the drop-down list, start from step 1;

If Custom is selected from the drop-down list, start from step 2.

1. Click Edit to enter the Templates Management interface. Select the template to be set and you
can edit the template name.

2. Set the time schedule for the selected template.
# Schedule Recording ofer to normal schedule recording. The schedule time bar is greenyellow.

£ NarmRecording (ofors to the schedule record for the alarm input or motion detection event. The
schedule time bar is red.

# Command | ofers to the schedule record triggered by command. The schedule time bar is

green.

e

Record triggered by command is only available for the ATM transactions when the ATM DVR

is added to CMS.
When the cursor turns to ﬁ?, you can edit the schedule time bar.
When the cursor turns to lF_______ﬁ, you can move the selected time bar you just edited.
When the cursor turns to .:::{}%b' you can lengthen or shorten the selected time bar.

3. Optionally, you can select the schedule time bar,
and then click the icon | *  to delete the selected time bar,
or click the icon L to delete all the time bars,

or click the icon to copy the time bar settings to the other dates.
4. Click OK to save the settings.

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom

template can be saved as template 01--08.

e

Up to 8 time periods can be set for each day in the record schedule.

Templates Management x
All-day Template # Schedule Recording| | & Alarm Recording & Command ®x |

Weekday Templ.
i) 2 4 B a 10 12 14 16 18 20 22 24

Alarm Template

1] 2 1 [ ] 10 1z 14 16 18 20 22 21
Template 01| 1 B e R

Template 02 [ 2 4 5 8 10 12 14 16 18 20 22 24

Template 03

Template 04
Template 05
Template 06 [ 2 4 [ 8 10 12 14 18 18 20 22 24
Template 07

Template 08 &0
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Custom Schedule x

& Schedule Recording| |4 Alarm Recording # Command ® Save as Schedule Template
i 2 1 g & 10 12 14 18 18 20 22 21
Mon .
a 2 4 ] 8 10 12 14 18 18 20 22 24
Tue :
Q 2 4 [ g 10 12 14 18 18 20 22 24
Wed '
Q 2 4 [ g 10 12 14 16 15 20 22 24
Thu
] 2 4 B g 1o 12 14 16 18 20 22 24
Fri
i 2 1 g & 10 12 14 18 18 20 22 21
Sat .
a 2 4 ] 8 10 12 14 18 18 20 22 24
sun :

3.1.2 Recording on Storage Server

Purpose:

The storage server performs as a NVR installed on the PC. The record files can be stored in the storage
server and you can search the files for remote playback.

Before you start:

The storage server application software needs to be installed and it is packed in the CMS software
package. When installing the CMS, check the checkbox Storage Server to enable the installation of

storage server.

Adding the Storage Server

Steps:

1. Click the shortcut icon i

n

You can also record the video files on the storage server installed on other PC.

on the desktop to run the storage server.

Open the Device Management page and click the Server tab.
Click Add New Device Type, select Storage Server and click OK.
Click Storage Server on the list to enter the Storage Server Adding interface.
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Organization Device for Management (0}

d clete emote Config N |
&8 Encoding Device Add Device Wodif Delete Remote Config |

Nickname = IP Device Serial No Net Status

Add New Device Type

Online Device (1) Refresh Every 158
Add to Client AddAll Modify Netinfo ~ Restore Default Password Filter
P “ | Device Type Port Device Serial No Added

172623106  STORAGE-SERVER 8000 XXRCOXXNHKKXXXHKKXXXKKXK o

Storage device can be added.
CVRICMS Storage Server

You can add the storage server in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.

® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

Formatting the HDDs

The HDDs of the storage server need to be formatted for the record file storage.

Steps:

1. Select the added storage server from the list and click Remote Config.

2. Click Storage->General, to enter the HDD Formatting interface.

3. Select the HDD from the list and click Format. You can check the formatting process from the
process bar and the status of the formatted HDD changes from Unformatted to Normal Status.

=

J NOTE
Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the
formatted HDDs will not be deleted.

HDD settings.

[m HDD No. | Capacity(MB) Free Space (_ Status Type Group Mo Property

1 321 1411 Unformatted Local Group00 ReadWrite
2 40479 403309 Unformatted Local Group00 Read\Write
3 334906 297092 Unformatted Local Group00 Read/\Write
[ 4 15899 7245 Unformatted Local Group00 ReadWrite
E s 1992294 546729 Unformatted Local Group00 ReadWrite

0%

Configuring Storage Server Record Schedule
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Before you start:

The storage server needs to be added to the client software and the HDDs need to be formatted for
the record file storage.

Steps:

1. Open the Record Schedule page.

2. Select the camera from the Camera Group list.

3. Check the checkbox Storage Server to enable recording on storage server.

4. Select the storage server from the drop-down list.

5. Select the record schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Record Schedule Template.

o

Click Advanced Settings to set the pre-record time, post-record time and video expired time.

Click Save to save the settings.

3.2 Remote Playback

Purpose:
The record files stored on the local device or the storage server can be searched by custom view,

camera or triggering event, and then can be played back remotely.

Click the -

»===. icon on the control panel,

or click View->Remote Playback to open the Remote Playback page.

View ~

1 T 5
Event v 5
Motion Detection
- i IPC1
@ IPC1_Cameral
+ — NVR
+ . IPC2
* . DVR
Alarm Input
2 < boae
S M T W T F S
26 127 28 29 30 M 1
2 3 4 5 8 7 8
9 10 11 12 13 14 15
e |
10|17 18|19 |20 |21 | 22 | N e e
23 24 25 2627 28 29 ——C TR i o o e om|3|
20l1/2/2lal56 e GED  CpD CGED I 3
Window01 H— 7
3 More Search Options =
Search 03
4 Search Result ~ Window04
Remote Playback Page

1 View List, Camera List and Event List
2 Calendar
3 Search Options
4 Search Result List
5 Display Window of Playback
6 Playback Toolbar
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7 Timeline

3.2.1 Normal Playback

Purpose:
The record files can be searched by custom view or camera for the Normal Playback.

Searching Record Files for Normal Playback

Steps:

1. Open the Remote Playback page.

2. Click ™ toexpand the View List or Camera List on the left-side.

3. Select the view or camera to be searched from the list.

4. Select the day to be searched on the calendar.
You can also click ¥ to show more search options, and then click the icon ﬂ to specify the
start time and end time for the search.

5. Click Search. The record files of the selected view or camera will be displayed on the Search

Result list. You can filter the results through the Filter text field.

(=5

(nore]
® You can also search the record files by the card number (only applicable to ATM DVR) or by the
file type.
® [f there are record files for that camera in that day, in the calendar, the icon for that day is
displayed as %4 Otherwise it is displayed as % .
® Up to 16 cameras can be searched simultaneously.
Search Result v
Filter
- @ DVR_Cameral
B 2013-06-27 00:00:00

B 2013-06-27 06:36:57

Normal Playback

After searching the record files for the normal playback, you can play back the record files in the
following two ways:
®  Playback by File List
Click the icon %1 in the toolbar to start the playback from the first record file;
or double-click the record file on the search result list to play the selected video.
®  Playback by Timeline
The timeline indicates the time duration for the record file, and the record files of different types

are color coded. Click on the timeline to play back the video of the specific time.

You can click === or | | to scale up or scale down the timeline bar.

You canclick '€ or ' * to go to the previous or the next time period.
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You can use the mouse wheel to zoom in or zoom out on the timeline.

i

low02

Window03

Window04

Normal Playback Toolbar:

| — | -

On the Normal Playback page, the following toolbar buttons are available:

Async/Sync Playback  Click to play back the record files synchronously/asynchronously.
L} Stop Playback Stop the playback of all cameras.

(Il B Pause/Start Playback Pause/Start the playback of the record files.

LS Single Frame Play back the record files frame by frame.

|2 &) Volume Click to turn on/off the audio and adjust the audio volume.

(L Full Screen Display the video playback in full screen mode. Press ESC to exit.

e

You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.2 Event Playback

Purpose:
The recordings triggered by motion detection or alarm input can be searched for Event Playback and

this function requires the support of the connected device.

Searching Record Files for Event Playback

Steps:
1. Open the Remote Playback page.
2. Click ™ toexpand the Event List on the left-side.
3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors.
4. Select the day to be searched on the calendar.
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You can also click * to show more search options, and then click the icon E to specify the
start time and end time for the search.

5. Click Search. The recordings from the selected cameras and sensors triggered by motion

detection or alarm input will be displayed on the Search Result list.

Event Playback

After searching the recordings triggered by the event, you can play back the record files in the
following two ways:
®  Playback by File List
Select the record file from the search result list, and then click the icon 2 inthe toolbar,
or double-click the record file to play the video on the display window of playback.
®  Playback by Timeline
The timeline indicates the time duration for the record file. Click on the timeline to play back the

video of the specific time.

e

You can click | =l or | | to scale up or scale down the timeline bar.

You can click '€/ or |® | to go to the previous or the next time period.
You can use the mouse wheel to zoom in or zoom out on the timeline.

Window01 | ‘

Window02

Window03

Window04

Event Playback Toolbar:

| — CRINTRINTS

On the Remote Playback page, the following toolbar buttons are available:

[ | Stop Playback Stop the playback of all channels.

| — |

Il B Pause/Start Playback Pause/Start the playback of record files.

LS Single Frame Play back the record files frame by frame.

a Previous Event Go to the playback of the previous event.

-'..’- Next Event Go to the playback of the next event.

|42 &% Volume Click to turn on/off the audio and adjust the audio volume.

.E. Full Screen Display the video playback in full screen mode. Press ESC to exit.
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You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.3 Synchronous Playback

Purpose:

In synchronous playback, the record files can be played back in synchronization.

n

Record files from up to 16 cameras can be played back simultaneously.

Synchronous Playback for Some Searched Cameras

Steps:

1. Start the normal playback of the searched cameras.

2. Click = in the toolbar, and then the record files in normal playback will be played in sync. The
icon B turnsto =,

3. To disable the synchronous playback, click the icon =
Synchronous Playback for All Searched Cameras

Steps:
1. Search the record files for the normal playback.
2. Click = in the toolbar to enable the synchronous playback. The icon == turnsto =%

3. Select the record file from the list and click -’.-,
or click on the timeline to start the synchronous playback for all searched cameras.

4. To disable the synchronous playback, click the icon =

,
Window01 ” ‘

Window02

Window03

Window04
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Chapter 4 Event Management

Purpose:
In CMS software, rules can be set up for triggers and linkage actions. You can assign linkage actions to
the trigger by setting up a rule. For example, when motion is detected, an audible warning appears or

other linkage actions happen.

Click the é icon on the control panel,

or click Tool->Event Management to open the Event Management page.

¥ CameraEvent A Alarminput Device Exception
Camera Group Select Event Type: Motion Detection | IPC2_Camera1 Event Configur. Copyto. I save
Search.  Enable
- . IPC1-Encoding Channel Arming Schedule All-day Template v Edit
@ IPC1_Camerat Arming Region

+ I NVR-Encoding Channel ¢ Sensitivity:

= I IPC2-Encoding Channel
o]

+ I DVR-Encoding Channel

Trigger Alarm Output Trigger Channel Record  Trigger ClientAction
Camera01  Audible Warning
~ Email Linkage
~ Alarm on E-map

< Alarm Triggered Pop-up Image

You can set different linkage actions for the following triggers:
Motion Detection

Tampering Alarm

PIR Alarm

Video Loss

Alarm Input

Device Exception

4.1 Configuring Motion Detection Alarm

Purpose:

A motion detection alarm is triggered when the client software detects motion within its defined area.
The linkage actions, including alarm output, channel record and client action can be set.

Steps:

1. Open the Event Management page and click Camera Event tab.

2. Select the camera to be configured and select Motion Detection as the event type.

3. Check the checkbox Enable to enable the function of motion detection.
4

Select the arming schedule template from the drop-down list.
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All-day Template: for all-day continuous arming.
Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM.
Template 01-09: fixed templates for special schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Arming Schedule Template.

5. Click-and-drag the mouse to draw a defined area for the arming region.
You can click the icon = = to set the whole video area as detection area, or click the icon ﬂ to
clear all the detection area.

6. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the
value is, the more sensitive the detection is.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4-1 Linkage Actions for
Motion Detection Alarm.

8. Optionally, click Copy to... to copy the event parameters to other channels.

Click Save to save the settings.

Select Event Type: Motion Detection ~ IPC2_Camera1 Event Configur... Copyto... H Save
~ Enable
Arming Schedule: All-day Template v Edit

Arming Region

ﬁﬂ % Sensitivity

1 ; 5

: o
Trigger Channel Record

Trigger Alarm Output / Trigger ClientAction

Camera01 /' Audible Warning
+ Email Linkage
/ Alarm on E-map

' Alarm Triggered Pop-up Image

Table 4-1 Linkage Actions for Motion Detection Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output .
external device connected to the port can be controlled.

Channel Record

Start the recording of the selected cameras when alarm is triggered.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image with alarm information pops up when alarm is triggered.

Alarm Triggered
Video Wall Display

Display the video on the Video Wall when alarm is triggered.
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Configuring Arming Schedule Template

Perform the following steps to configure the arming schedule template:

If Template 01-09 is selected in the drop-down list, start from step 1;

If Custom is selected in the drop-down list, start from step 2.

Steps:
1. Click Edit to enter the Templates Management interface. Select the template to be set and you
can edit the template name.
2. Set the time schedule for the selected template.
When the cursor turns to , you can edit the schedule time bar.
When the cursor turns to -‘n)", you can move the selected time bar you just edited.
When the cursor turns to E{}, you can lengthen or shorten the selected time bar.
3. Optionally, you can select the schedule time bar,
and then click the icon ' *  to delete the selected time bar,
or click the icon | B to delete all the time bars,
or click the icon to copy the time bar settings to the other dates.
4. Click OK to save the settings.

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom

template can be saved as template 01--09.

e

Up to 8 time periods can be set for each day in the arming schedule template (depending on the
capacity of device).

Templates Management x

All-day Template % &
Weekday Templ_
0 2 4 [ 8 10 12 14 16 18 20 22 24
Mon [0
Template 01|
0 2 4 [} 8 10 12 1 18 18 20 2z 2
Template 02 Tue { ‘ ‘ ‘ ‘ S e ‘ i —
Template 03 1] 2 4 5 8 10 12 14 16 18 20 22 24
Wed [T e
Template 04
o 2 4 -] 8 10 12 14 16 18 20 22 24
Template 05 L
o 2 4 [ 8 10 1z 14 16 18 0 22 24
Template 06 Fi
26 o 2 4 [ 8 10 12 14 16 18 20 2 24
e f . . . . . ! : 8
Template 08
0 2 4 [ 8 10 12 14 18 18 0 2 24
Template 09 &0
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Custom Schedule x

® ﬁ Save as Schedule Template

Thu

Fri

4.2 Configuring Tampering Alarm

Purpose:

A tampering alarm is triggered when the camera is covered and the monitoring area cannot be viewed.

The linkage actions, including alarm output and client action can be set.

Steps:

1. Open the Event Management page and click the Camera Event tab.

2. Select the camera to be configured and select Tampering Alarm as the event type.

3. Check the checkbox Enable to enable the function of tampering alarm.

4. Select the arming schedule template from the drop-down list.
If you need to edit or customize the template, see Configuring Arming Schedule Template.

5. Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when tampering alarm occurs.

6. Click-and-drag the mouse to draw a defined area for the arming region.
Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.

8. Check the checkboxes to activate the linkage actions. For details, see Table 4-2 Linkage Actions for
Tampering Alarm.

9. Optionally, click Copy to... to copy the event parameters to other cameras.

10. Click Save to save the settings.
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Select Event Type: |Tampering Alarm v | IPC2_Camera1 Event Configur... Copyto... H Save
~ Enable
Arming Schedule: All-day Template v Edit

Trigger Camera:

Arming Region

* Sensitivity:

Trigger Alarm Output  Trigger ClientAction

/' Audible Warning
/ Email Linkage
~/ Alarm on E-map

/ Alarm Triggered Pop-up Image

Table 4-2 Linkage Actions for Tampering Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the

Alarm Output )
external device connected to the port can be controlled.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.
Alarm on E-map Display the alarm information on the E-map.
Alarm Triggered The Image of the triggered camera pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video of the triggered camera on the Video Wall when alarm is
Video Wall Display | triggered.

4.3 Configuring PIR Alarm

Purpose:

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view.

The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc.,
can be detected.

’;QHLT.

(nore]
The PIR Alarm function requires the support of connected device.

Steps:
1. Open the Event Management page and click the Camera Event tab.
2. Select the camera to be configured and select PIR Alarm as the event type.
3. Check the checkbox Enable to enable the function of PIR alarm.
4

Input a descriptive name of the alarm.
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5. Check the checkboxes to activate the linkage actions. For details, see Table 4-3 Linkage Actions for
PIR Alarm.
Optionally, click Copy to... to copy the event parameters to other channels.

Click Save to save the settings.

Select Event Type: PIR Alarm ~ IPC1_Camera1 Event Configur. Copy to. H Save
+/ Enable

Alarm Name: 124

Trigger Alarm Qutput  Trigger Channel Record  Trigger Client Action
' Camera01 < Audible Warning
+/ Email Linkage
</ Alarm on E-map

+ Alarm Triggered Pop-up Image

Table 4-3 Linkage Actions for PIR Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output )
external device connected to the port can be controlled.

Channel Record Start the recording of the selected cameras when alarm is triggered.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.
Alarm on E-map Display the alarm information on the E-map.
Alarm Triggered The Image with alarm information pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video on the Video Wall when alarm is triggered.
Video Wall Display

4.4 Configuring Video Loss Alarm

Purpose:

When the client software cannot receive video signal from the front-end devices, the video loss alarm
will be triggered. The linkage actions, including alarm output and client action can be set.

Steps:

1. Open the Event Management page and click Camera Event tab.

2. Select the camera to be configured and select Video Loss as the event type.

3. Check the checkbox Enable to enable the function of video loss alarm.
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Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when video loss alarm occurs.

Check the checkboxes to activate the linkage actions. For details, see Table 4-4 Linkage Actions for
Video Loss Alarm.

Optionally, click Copy to... to copy the event parameters to other cameras.

Click Save to save the new settings.

Select Event Type: Video Loss ~  IPC2_Camera1 Event Configur. Copy to. H Save
+/ Enable
Arming Schedule: All-day Template w Edit
Trigger Camera v
Trigger Alarm Output + Trigger ClientAction

+ Audible Warning
+/ Email Linkage
~ Alarm on E-map

< Alarm Triggered Pop-up Image

Table 4-4 Linkage Actions for Video Loss Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output )
external device connected to the port can be controlled.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.
Alarm on E-map Display the alarm information on the E-map.
Alarm Triggered The Image of the triggered camera pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video of the triggered camera on the Video Wall when alarm is

Video Wall Display | triggered.

4.5 Configuring Alarm Input Linkage

Purpose:
When a device's alarm input port receives a signal from an external alarm device, such as smoke
detector, doorbell, etc., the alarm input linkage actions are triggered for notification.

Before you start:
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Add the alarm inputs to the client, click Import on the Group Management interface, click the Alarm

Input tab and import alarm inputs into groups for management.

Steps:

A o

Open the Event Management page and click the Alarm Input tab.
Select the alarm input channel to be configured.

Check the checkbox Enable.

Input a descriptive name of the alarm.

Set the alarm status according to the alarm input device.

Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4-5 Linkage Actions for

Alarm Input.

8. Optionally, click Copy to... to copy the event parameters to other alarm inputs.

Click Save to save the settings.

DVR_A1 Event Configuration Copyto H Save
-~/ Enable
Alarm Name:
Alarm Status: @ Mormal Open Mormal Closed
Arming Schedule All-day Template v Edit
Trigger Alarm Qutput Trigger Channel Record "/ Trigger ClientAction
A1 Camera01 + Audible Warning
A=2 Camera02 + Email Linkage
A3 Camera03 +/ Alarm on E-map
A-=4 Camera04 + Alarm Triggered Pop-up Image

Camera05

Camera0f

Camera07

Camera08

Camera09

Cameral0

Camerall

Cameral2

Cameral3

Cameral4
Cameral5

Cameral6

Table 4-5 Linkage Actions for Alarm Input

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the

external device connected to the port can be controlled.

Channel Record

Start the recording of the selected cameras when alarm is triggered.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image with alarm information pops up when alarm is triggered.

Alarm Triggered

Video Wall Display

Display the video on the Video Wall when alarm is triggered.
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4.6 Configuring Device Exception Linkage

Open the Event Management page and click the Device Exception tab.

Select the device to be configured.

Select the device exception type, including HDD full, HDD exception, illegal login, etc.
Check the checkbox Enable.

Check the checkboxes to activate the linkage actions. For details, see Table 4-6 Linkage Actions for

Steps:
1.
2
3
4,
5
Device Exception.
6.

Optionally, click Copy to... to copy the event parameters to other devices.

Click Save to save the settings.

DVR Event Configuration Copyto I save

Exception Type: HDD Full 2

~/ Enable

Linkage Action

Trigger Alarm Output +/ Trigger ClientAction

A>1
A2
A>3

A4

</ Audible Warning

+ Email Linkage

Table 4-6 Linkage Actions for Device Exception

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the

external device connected to the port can be controlled.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

4.7 Viewing Alarm and Event Information

The information of recent alarms and events can be displayed. Click the icon E in Alarms and Events
Toolbar to show the Alarms and Events panel.
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@& .- @ #= Noewmailaccountis configured, and all the sending operations are stopped

Index + | Alarm Time Alarm Source Alarm Details Alarm Content Live View | SendE... | Note

1 2013-06-28 16:57.36 Encoding Device:IPC2 ‘Camera: IPC2_Camera? Trigger... Motion Detection Alarm Start "]

Alarm Ewvent -/ Motion Detection -/ Video Exception -~ AlarmInput -~ Device Exception

On the Alarms and Events panel, the following toolbar buttons are available:

]

o]
o]
2]

Clear Info Clear the information of alarms and events displayed on the list.
Enable/Disable Alarm

Triggered Pop-up Click to enable/disable image pop-up when alarms occur.
Image

n Enable/Disable Audio Click to enable/disable the audio warning for the alarm.

n Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel.
Maximize Maximize the Alarms and Events panel in a new tab page.

H Show/Hide Click to show/hide the Alarms and Events panel.

Viewing Alarms Information

Different alarm types can be displayed on the panel: Motion Detection, Video Exception, Alarm Input

and Device Exception. You can check the checkbox to enable the displaying of that type alarm.

Before you start:

To display the alarms, the event parameters need to be configured.

Steps:

1. Click the Alarm tab.

2. Check the checkboxes of different alarm types.

3. When an alarm occurs, the icon E twinkles to call attention. The alarm information, including
the time, source, details and content will be displayed.
Click %' to get a live view of the alarm triggered camera.
Click to send an Email notification of the alarm to one or more receivers.
Click EB to display the video of alarm triggered camera on the Video Wall. This function is only
available when the decoding device is added.
Click under the Note column to input a prompt message for the alarm.

4. To clear the alarm information, click the icon H, or right-click on an alarm log and then click

Clear.

Viewing Events Information

Purpose:

The abnormal events of the client software, such as the live view failure, device disconnection, can

also be displayed.

Steps:

1.

Click the Event tab.
The event information, including the time and detailed description will be displayed.

To clear the event information, click the icon H, or right-click on the event log and then click
Clear.

48



User Manual of CMS

Chapter 5 E-map Management

Purpose:

The E-map function gives a visual overview of the locations and distributions of the installed cameras
and alarm input devices. You can get the live video of the cameras on the map, and you will get a

notification message from the map when alarm is triggered.

[~]
Click the icon on the control panel,

or click View->E-map to open the E-map page.

Search.
1 G oo

L3 PC1

NVR
+ JIPC2

— 2
«
| MapPreview | Edithap [* \_:‘q = JE J 9// &
3
E-map Page

1 Group List
2 Map Display Area
3 E-map Toolbar

5.1 Adding an E-map

Purpose:
An E-map needs to be added as the parent map for the hot spots and hot regions.
Steps:

Open the E-map page.

Select a group for which you want to add a map.

Click the icon & in the Map Display Area to open the map adding dialog box.

1.

2

3.

4. Input a descriptive name of the added map as desired.

5. Clicktheicon |~ and select a map file from the local path.
6

Click OK to save the settings.

(=

e

® The picture format of the map can only be *.png, *.jpg or *.bmp.
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® Only one map can be added to a group.

E-map Info x

Map Name: Main Map1
Path: C:Usersfzhangriu/Deskiop/Ma... ||

The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on
the map. You can click-and-drag the yellow window in the lower-right corner or use the direction

buttons and zoom bar to adjust the map area for view.

Search p State Forest
3 %
+ ipet <X
< ®
+ CINR @
+ @
+ Sipc2
| ® &
‘Windham
Figh Peak
seit r * Roxbury .
Platte) Bearpen
I State Forest 4
=) State Forest Catsiill Park
= 28 Border Katerskit/
@® ® oo s Lake Comp &
‘Mountain
L
“«
® .
4 Shandaken West il Mogrtan -2
® ) 5 . Mountain
@ Dry Brook ayre A
! ' fadoy SECanter A Indian Head
Retaryor Wid Forest s
. p . Woodstock
Mdde Balsam Lake
3 Wid Focest @
3¢
3t
L3 2
» Sundown
Willowemoc »
Wid Forest Willowemoc P,
EditMap

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or

map preview mode.

Edit Map

E-map Toolbar in Map Preview Mode:
Map Preview | Editiap | VSR )

On the E-map page, the following toolbar buttons are available:

Modify Map Modify the map information, including the map name and file path.
@ Delete Map Delete the current map.

Add Camera Add a camera as the hot spot on the map.

Add Alarm Input Add an alarm input sensor as the hot spot on the map.

ﬁ Add Hot Region Add a map as the hot region on the current map.

Modify Modify the information of the selected hot spot or hot region.
Delete Delete the selected hot spot or hot region.
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.,_ Clear Alarm Info Clear the alarm information displayed on the map.

el

@ Back to Parent Map Go back to the parent map.

5.2 The Hot Spot Function

Purpose:

The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots
show the locations of the cameras and alarm inputs, and you can also get the live video and alarm
information of the surveillance scenarios through the hot spots.

5.2.1 Adding Hot Spots

Adding Cameras as Hot Spots

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Click the icon &3 in the toolbar to open the Add Hot Spot dialog box.

3. Check the checkboxes to select the cameras to be added.

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon.

5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons
of added cameras changes from @to © inthe group list. You can click-and-drag the camera
icons to move the hot spots to the desired locations.

You can also click-and-drag the camera icons from the group list to the map directly to add the

hot spots.
Linked Camera Hot Spot Name Hot Spot Color Hot Spotlcon  *
DVR_Cameral DVR_Cameral b Green a ‘
DVR_Camera2 DVR_Camera2 W Green @
DVR_Camera3 DVR_Camera3 I Green @
DVR_Camerad DVR_Camerad b Green a
DVR_Camera5 DVR_Cameras b Green a
DVR_Cameraf DVR_Cameraf b Green a
DVR_Camera? DVR_Camera7 W Green @
DVR_Cameras DVR_Camerag B Green @
DVR_Camerad DVR_Camerad bl Green a
DVR_Camera10 DVR_Cameral0 b Green a
DVR_Camerall DVR_Camerall b Green a

Adding Alarm Inputs as Hot Spots
Steps:
1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Click the icon ﬂ in the toolbar to open the Add Hot Spot dialog box.
3. Check the checkboxes to select the alarm inputs to be added.
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4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon.

Click OK to save the settings. The alarm input icons are added on the map as hot spots and the

icons of added alarm inputs changes from “# to L] in the group list. You can click-and-drag

the alarm input icons to move the hot spots to the desired locations.

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to

add the hot spot.

5.2.2 Modifying Hot Spots

Purpose:

Linked Alarm Input
DVR_A1
DVR_AZ
DVR_A3
DVR_A4
DVR_AS
DVR_AB
DVR_AT
DVR_AB
DVR_A9
DVR_A10

DVR_AT

Hot Spot Name
DVR_A1
DVR_AZ
DVR_A3
DVR_Ad
DVR_AS
DVR_46
DVR_AT
DVR_A8
DVR_A9
DVR_A10

DVR_A11

Add Hot Spot x

Hot Spot Color Hot Spoticon  *.

-

Green

Green

Green

Green

Green

Green

Green

Green

Green

Green

ENEREENENEEER
RN R R R AR

Green

You can modify the information of the added hot spots on the map, including the name, the color, the

icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot spot icon on the map and then click ﬁ in the toolbar,
or double-click the hot spot icon on the map to open the Modify Hot Spot dialog box.

3. You can edit the hot spot name in the text field and select the color, the icon and the linked

camera or alarm input.

4. Click OK to save the new settings.

To delete the hot spot, select the hot spot icon and click [\ in the toolbar.

Modify Hot Spot x Modify Hot Spot x

Hot Spot Name: DVR_Camera1

Linked Camera:

~ DVR_Cameral
DVR_Camerad
DVR_Camera5
DVR_Cameraé
DVR_Camera7?
DVR_Camera8
DVR_Camerag
DVR_Camera10
DVR_Camerall
DVR_Cameral2

Hot Spot Color: Green

Hot Spoticon: '@y

Hot Spot Name: DVR_A1

Linked Alarm Input:

Hot Spot Celor. [ Green

/I DVR_A1 3
DVR_A3
DVR_Ad
DVR_AS
DVR_AG
DVR_AT
DVR_A8
DVR_A9
DVR_A10

DVR_A11 E

Hot Spoticon. @

Cance\ Cancel
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5.2.3 Previewing Hot Spots

Steps:

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.

2. Double-click the camera hot spots, and you can get the live video of the cameras.

3. If there is any alarm triggered, an icon B il appear and twinkle near the hot spot. Click the
alarm icon, and then you can check the alarm information, including alarm type and triggering

time.

NOTE

To display the alarm information on the map, the Alarm on E-map functionality needs to be set

as the alarm linkage action.

State Forest
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| >
v
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Plattekil
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Resavar
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Wid Forest - Wilowemoo i
Hurley Kingston ]

5.3 The Hot Region Function

Purpose:
The hot region function links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called child

map while the map to which you add the hot region is the parent map.

s,

A map can only be added as the hot region for one time.

5.3.1 Adding Hot Regions

Before you start:
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Add another map to the group.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select an added map as the parent map.

3. Click the icon @ in the toolbar to open the Add Hot Region dialog box.

4. Check the checkbox to select the child map to be linked.

5. Optionally, you can edit the hot region name, and select the hot region color and icon.

6. Click OK to save the settings. The child map icons are added on the parent map as the hot regions.

You can click-and-drag the child map icons to move the hot regions to the desired locations.

Add Hot Region x

Linked Map Hot Region Name Hot Region | Hot Region Icon
Map1 Map1 Wl Green M
Map2 Map2 Bl Green M

5.3.2 Modifying Hot Regions

Purpose:

You can modify the information of the hot regions on the parent map, including the name, the color,

the icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot region icon on the parent map and then click .2 in the toolbar,
or double-click the hot region icon to open the Modify Hot Region dialog box.

3. You can edit the hot region name in the text field and select the color, the icon and the linked
child map.

4. Click OK to save the new settings.

To delete the hot region, select the hot region icon and click = in the toolbar.
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Modify Hot Region *

Hot Region Name: Map1
Linked Map:
~ Map1
Map2
Hot Region Color: [ Green [v Hot Region Icon: |8 [v

5.3.3 Previewing Hot Regions

Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.
2. Click the hot region icon to go to the linked child map.
3. The hot spots can also be added on the hot regions.
4. You can click the icon @ in the toolbar to go back to the parent map.
You can also click the icon & in the toolbar to clear the alarm information.

(30)
@ (30 g
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@ 2
( o
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Plattekt  Map1 Bearpen A @ a
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Chapter 6 Log Management

Purpose:

2 types of log files are provided: client logs and server logs. The client logs refer to the log files of the

client and are stored on the local PC; the server logs refer to the log files of the connected devices and

are stored on the local device.

Click the

Log Search Client Log Lists

o ClientLogs

ServerLogs

Start Time

2]

2013-06-29 00:00:00
End Time:

2013-06-20 23:50:50

3]

Q Search

Total 0 Page 11

Searching Log Files

Steps:
1. Open the Log Search page.

Operation Time “ |UserName | Log Type Description

= icon on the control panel to open the Log Search page.

[3 LogFitter [ Backup Log

Device Name Device Type Gro

1] Page Go

Select the log type. If Server Logs is selected, then click to specify the device for search.

2

. . R . . .
3. Clicktheicon LY to specify the start time and end time.
4

Click Search. The log files between the start time and end time will be displayed on the list.

You can check the operation time, description and other information of the logs.

;ﬂ:
[NoTE

Up to 90000 items of logs can be displayed. Please narrow the time range or filter the log type

for search if there are too many log files.
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Operation Time

2013-06-29 132041
2013-06-29 132145
2013-06-29 13:23:30
2013-06-29 13:24.03
2013-06-29 13:24:41
2013-06-29 13:25:03
2013-06-29 13:26:29
2013-06-29 13:27.28
2013-06-29 13:27.58
2013-06-29 13:29:00
2013-06-29 13:29:05
2013-06-29 13:30:20
2013-06-29 13:37:57
2013-06-29 13:38:34
2013-06-29 13:40:20
2013-06-29 13:40:32
2013-06-29 13:41:56
2013-06-29 13:42:29

2013-06-29 13:42:58

Filtering Log Files

Purpose:

4 |UserName |LogType

root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root
root

root

System Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Alarm Log
Operation Log
Alarm Log
Operation Log
Operation Log
Alarm Log
Operation Log
Alarm Log
Alarm Log

Alarm Log

Description
User Login
Motion Detection A
Motion Detection A

Motion Detection A

Motion Detection A.
Motion Detection A.
Motion Detection A.
Motion Detection A.
Motion Detection A.

Motion Detection A.

Add Map

Motion Detection A.

Add Map

Add Map

Motien Detection A.

Add Hot Region

Motien Detection A.

Hotion Detection A

Hotion Detection A

Device Name Device Type Gro
DVR Encoding Device DVF
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC
IPC2 Encoding Device IPC

DVF
IPC2 Encoding Device IPC

IPC

IPC
DVR Encoding Device  DVF

DVF
IPC2 Encoding Device  IPC
IPC2 Encoding Device  IPC
IPC2 Encoding Device  IPC

After searched out successfully, the log files can be filtered by the keyword or condition, and thus you

can find the logs as you want.
Steps:
1. Click Log Filter or the icon

-

on the Log Search page to expand the Log Filter panel.

2. Select Filter by Keyword, and then input keyword for filtering in the text field; or

select Filter by Condition, and then specify log information in the drop-down list.

Optionally, you can click More... to filter the log files more accurately.

Click Filter to start filtering. You can click Clear Filter the clear the filtering.

Server Log Lists

Filter by Keyword:
+ Filter by Condition:
Majar Type:

Minor Type:

Backing up Log Files

Purpose:

All

All

[+ Log Filter [ Backup Log
Clear Filter
More
i
Filter

The log files, including the client logs and server logs, can be exported for backup.

Steps:

1. Click Backup Log to open the Backup Log dialog box.

2. Click the icon

and select a local saving path.

3. Click Backup to export the log files for backup.

You can click File=>Open Log File to check the information of the backup log files on local PC.
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Saving Path:

Backup Log
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Chapter 7 Account Management and System

Configuration

7.1 Account Management

Purpose:
Multiple user accounts can be added to the client software, and you are allowed to assign different
permissions for different users if needed.
(]
Click the “ icon on the control panel,

or click Tool->Account Management to open the Account Management page.

UserList Add User Edit User Delete User
Index UserName  Type

1 raot Super User

e

The user account you registered to log in the software is set as the super administrator.

Adding the User

Steps:

1. Open the Account Management page.

2. Click Add User to open the Add User dialog box.

3. Select the user type from the drop-down list. 2 types of user accounts are selectable:
Administrator: The administrator account has all permissions by default, and can modify the
passwords and permissions of all operators and its own account.

Operator: The operator account has no permission by default and you can assign the permissions
manually. An operator can only modify the password of its own account.
Input the user name, password and confirm password as desired.

Check the checkboxes to assign the permissions for the created user.
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6. Optionally, you can click Default Permission to restore the default permissions of this user.

7. Click Save to save the settings.

® The user name cannot contain any of the following characters: /\ : * ? “ <> |. The administrator
password cannot be shorter than 6 characters, and the operator password cannot be empty.

® Up to 50 user accounts can be added for the client software.

Add User x

User Information

User Type: Administrator v User Wame:

Password, Confirm Password:

User Live View related

Al ~| =) ¥ DVR

~ Live View ~ DVR_Cameral

~ PTZ Control ~/ DVR_Cameraz2

-~/ Capture ~/ DVR_Camera3 b
~ Record ~ DVR_Camera4

< Camera Settings 5 ~/ DVR_Camera5

/' Play Back Remote Record File(s) ~ DVR_Cameraf

+ Download Remote Record File(s) ~ DVR_Camera7?

~/ Remote Recording ~/ DVR_Camera8

' Two-way Audio ~/ DVR_Camera9

+/ 8ynchronization ~ DVR_Cameral0

/' Picture Backup ~/ DVR_Camerall

~/ Backup Record File(s) - ~/ DVR_Cameral2 =

Default Permission

Managing the User

Purpose:

After created successfully, the user account is added to the user list on the Account Management page.
You can edit or delete the information of the user accounts.

To edit the information of the user, select the user from the list, and click Edit User.

To delete the information of the user, select the user from the list, and click Delete User.

7.2 System Configuration

Purpose:
The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email
settings can be configured.

Click the == icon on the control panel,

or click Tool->System Configuration to open the System Configuration page.
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System Configuration x

Set frequently used parameters
=5 File (Log expired time, display scale, play performance, etc.).

-
= Keyboard and Joystick

Log Expired Time: AMonth ~
E‘ Alarm Sound
View Scale Full Screen v
 Email
— Network Performance: MNormal| |Better| |Best
Play Performance: Real Time ~

</ Enable Screen Toolbar Display
Enable Auto-login
+/ Prioritize the Playback of Record Files on Storage Server
+/ Resume Live View Staius
+/ Auto-change Stream Type

Auto Time Adjustment: 00:00:00

Default Value Save

You can click Default Value to restore the defaults of all the system configurations.

7.2.1 General Settings

Purpose:

The frequently-used parameters, including the log expired time, view scale, etc., can be set.
Steps:

1. Open the System Configuration page.
Click the General tab to enter the General Settings interface.

2
3. Configure the general parameters. For details, see Table 7-1 General Parameters.
4. Click Save to save the settings.

Set frequently used parameters

(Log expired time, display scale, play performance, etc.).

Log Expired Time: AMaonth e
View Scale: Full Screen ~
Network Performance: Normal| | Better | | Best|

Play Performance: Real Time ~

-/ Enable Screen Toolbar Display
Enable Auto-login
-/ Prioritize the Playback of Record Files on Storage Server
/| Resume Live View Status
-/ Auto-change Stream Type

Auto Time Adjustment: 00:00:00
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Table 7-1 General Parameters

Parameters

Descriptions

Log Expired Time

The time for keeping the log files, once exceeded, the files will be deleted.

View Scale

The view scale of the video in live view or playback. It can be set as Full
Screen, 4:3, 16:9 or Original Resolution.

Network Performance

The current network conditions. It can be set as Normal, Better or Best.

Play Performance

The play performance of the live video. It can be set as Shortest Delay, Real

Time, Balanced or Fluency.

Enable Screen Toolbar
Display

Show the toolbar on each display window in live view or playback.

Enable Auto-login

Log in the client software automatically.

Prioritize the Playback
of Record Files on

Storage Server

Play back the video files recorded on the storage server preferentially.

Otherwise, play back the video files recorded on the local device.

Resume Live View
Status

Resume the latest live view status after you log in the client again.

Auto-change Stream
Type

Change the stream type automatically in live view according to the size of

the display window.

Auto Time Adjustment

Adjust the time automatically at a specified time point.

7.2.2 File Saving Path Settings

Purpose:

The video files from manual recording, the captured pictures and the system configuration files are

stored on the local PC. The saving paths of these files can be set.

Steps:

1. Open the System Configuration page.

Click the File tab to enter the File Saving Path Settings interface.

2
3. Click the icon
4

and select a local path for the files.

Click Save to save the settings.
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Set file saving path

(e-g. record files, pictures and device configuation files, etc_)

Saving Path of Video File

[cucmsideor

Saving Path of Pictures
C:{CMSicapture/
Saving Path of Configuration File

Cuicmsiconfigi

7.2.3 Keyboard and Joystick Shortcuts Settings

Purpose:

Certain keyboard can be connected to the client and be used to control the PTZ cameras. You can set
the shortcuts of PC keyboard and USB joystick to get quick and convenient access to the commonly
used actions.

Steps:

1. Select the COM port from the drop-down list if the keyboard is connected.

2. Select a certain function from the list.

3. Double-click the item field under the PC Keyboard or USB Joystick column.

4. Select the compound keys operation or USB joystick operation from the drop-down list.

5

Click Save to save the settings.

Configure keyboard COM
PC keyboard and USB joystick shortcuts, etc

COM Joystick: MULL ~

@ Setup shortcuts of PC keyboard and USB joystick for frequently used functions of the system.

Index Function PC Keyboard USB Joystick
1 Capture Cirl + Print Screen ‘ ‘
2 Speed Up |
3 Speed Down
4 Focus (+) Ctrl + Home
5 Focus (-) Ctrl + End
6 Zoom In (+) Ctrl ++
7 Zoom Qut () Cirl + -
8 IRIS (+) Ctrl + Page Up
9 IRIS (-) Ctrl + Page Down
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7.2.4 Alarm Sound Settings

Purpose:

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client
can be set to give an audible warning and the sound of the audible warning can be configured.

Steps:

1. Open the System Configuration page.

Click the Alarm Sound tab to enter the Alarm Sound Settings interface.

Click the icon | and select the audio files from the local path for different alarms.

2

3

4. Optionally, you can click the icon '* ! fora testing of the audio file.
5

Click Save to save the settings.

[INoTE

The format of the audio file can only be *wav.

Set alarm sound

(e-g. motion detection alarm video exception alarm, alarm input and device exception alarm)

Motion Detection:

|motion.wav || ¥4

Video Exception:

video_abnormal wav || g

Alarm Input:

alarm_input wav - || g
Device Exception:

device_abnormal wav || ¥4

7.2.5 Email Settings

Purpose:
An Email notification can be sent when a system alarm occurs. To send the Email to some specified
receivers, the settings of the Email need to be configured before proceeding.
Steps:
1. Open the System Configuration page.
2. Click the Email tab to enter the Email Settings interface.
3. Input the required information.
SMTP Server: Input the SMTP Server address.
Port: Input the communication port of Email service. The port is 25 by default.
User Name: Input the user name of the sender Email address.
Password: Input the password of the sender Email address.
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Sender Address: Input the Email address of the sender.

Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set.

Optionally, you can check the checkbox Enable SSL to increase the security of email sending.

Optionally, you can click Send Test Email to send an email to the receiver for test.

Click Save to save the settings.

Set email parameters including sender and recipient

SMTP Server: [ ]
Port: 25
User Name:
Password
SenderAddress
Receiver 1
Receiver 2
Receiver 3
Enable SSL

Send Test Email
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Chapter 8 Forwarding Video Stream through

Stream Media Server

Purpose:
There is always a limit of the device remote access number. When there are many users wanting to get
remote access to the device to get the live video, you can add the stream media server and get the

video data stream from the stream media server, thus to lower the load of the device.

8.1 Adding the Stream Media Server

Before you start:

The stream media server application software needs to be installed and it is packed in the CMS
software package. When installing the CMS, check the checkbox Stream Media Server to enable the
installation of stream media server.

Steps:

1. Click the shortcut icon @‘ on the desktop to run the stream media server.
o
Nore|
You can also forward the video through the stream media server installed on other PC.
2. Open the Device Management page and click the Server tab.
Click Add New Device Type, select Stream Media Server and click OK.
4. Click Stream Media Server on the list and then click Add Device.
You can add the stream media server in the following two ways:
® Adding Stream Media Server Manually
Perform the following steps to add the stream media server manually:
1) Select IP Address as the adding mode.
2)  Input the nickname and IP address of the stream media server. The default port value is
554.

3) Click Add to add the stream media server to the client software.

Adding Mode:

@ |PAddress IP Segment

Nickname “ ]
IP Address

Port:

® Adding Stream Media Server by IP Segment
Perform the following steps to add the stream media server by IP segment:
1) Select IP Segment as the adding mode.
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2) Input the start IP and end IP. The default port value is 554.

3) Click Add to add the stream media server to the client software.

Adding Mode

IP Address @ |P Segment

Start IP:

End IP:

Port:

s

For one client, up to 16 stream media servers can be added.

8.2 Adding Cameras to Stream Media Server to Forward

Video Stream

Purpose:

To get the video stream of a camera via stream media server, you need to connect the camera to the
stream media server.

Steps:

1. Select the stream media server from the list.

2. Click Configure to enter the Stream Media Server Settings interface.
3. Select the cameras of which the video stream is to be forwarded via the stream media server.
4. Click OK to save the new settings.
5. Go the Main View page and start the live view of the cameras again. You can check the channel
number of the video stream forwarded through or sent from the stream media server.
=

For one stream media server, up to 64 channels of video stream can be forwarded through it and

up to 200 channels of video stream can be sent to clients from it.

& p .
Seach L L O] No. of channels 3 17:04:20
Al E Configure About R — z 2013-06-29
- = | DVR-Encoding Channel
7 (& DVR_Camera2 Enter 172623106 52315 2013-06-29 17:04:08
7 (@& DVR_Camera3 Enter 172623108 52316 2013-06-29 17.04:08
Enter 172623108 52317 2013-06-29 17.04:08

@ DVR_Camera4
@ DVR_Cameras
@ DVR_Camerab
@ DVR_Camera?
& DVR_Camerag
@ DVR_Camerad
@ DVR_Cameral0

@ DVR_Camera'l
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Chapter 9 Decoding and Displaying Video on
Video Wall

The Video Wall module is only available when the decoding device is added to the client. It provides
the video decoding functionality, and the decoded video stream can be displayed on the Video Wall
for an attention-grabbing performance.

(===

(===
Click the WEE icon on the control panel,

or click View->Video Wall to open the Video Wall page .

Camera Default Video Wall
Search...

+/ZJ DVR
+) S Ipct
+ ZJ VR
+ 3 IPC2

+/ ' Speed Dome

Layout

Third Party Devices

PTZ

£ER., Enter video wall Config mEE=EE e ;H

9.1 Adding the Decoding Device

Purpose:

To display the video on the Video Wall, the decoding device needs to be added to the client.
Steps:

1. Open the Device Management page and click the Server tab.

2. Click Add New Device Type, select Decoding Device and click OK.

3. Click Decoding Device on the list to enter Decoding Device Adding interface.
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= sever W Group

Organization Device for Management (1)

@ Encoding Device .~ Add Device Modify Delete Remote Config Filter
Nickname = |IP Device Serial No. Net Status.
£l Storage Server Decader 17262265 XXCOXXKHHKKKKXXXXXRHHNKKKK 3

il Stream Vedia Server

Online Device (0) Refresh Every 155
Add to Client < AddAll Modify Netinfo  Restore Default Password Filter
P | Device Type Port Device Serial No. Added

Decoding device can be added
Decoder/CHS Decoding Server

You can add the decoding device in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.

® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

9.2 Configuring Video Wall Settings

Purpose:

After the decoding device is added successfully, the parameters of Video Wall need to configured for

video display.

Steps:

1. Open the Video Wall page.

2. Click Enter Video Wall Config to enter the Video Wall Configuration interface.

3. Thereisa 3*3 video wall on the screen by default. You can add a new video wall if needed.
Perform the following steps to add a new video wall:

1) Click the icon in the toolbar to open the Add Video Wall dialog box.
2) Input the nickname, the number of rows and columns of the video wall.

3) Click Add.
T

Video Wall Name: [| l

Row: 3

Column: 3

Cancel

To modify the video wall, select the video wall, and click the icon @ in the toolbar.
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To delete the video wall, select the video wall, and click the icon » in the toolbar.
4. Click-and-drag the decoding channel on the left-side list to the display window of video wall, to

connect them one-to-one correspondence. You can click B the upper-right corner of the
display window to release the connection.

NOTE

® Up to 4 video walls can be added to the client software.
® The total number of the display windows on the video wall should be no more than 100.

® The ranges of the row number and column number are both between 1 and 20.

camera Default Video Wall

Search..

-/ DVR
@ DVR_Cameral Decoder:VGA 1 Decoder:VGA 2
@ DVR_Camera2
& DVR_Camera3
@ DVR_Camerad
@ DVR_Cameras
& DVR_Camerab
@ DVR_Camera?
@ DVR_Cameras
@& DVR_Camerad
@ DVR_Cameraid
@ DVR_Camerall
& DVR_Camera12
@ DVR_Camerai3
@ DVR_Cameral4
@ DVR_Camerat5
@ DVR_Camerals
@ DVR_IP Cameral

2 MWD 1D Pamaran

Layout ~

Third Party Devices "

PTZ ~

£EF., Enter video wall Config | EEE e ;H

9.3 Displaying Video on Video Wall

Purpose:

After the settings of the video wall are configured, the video stream from the cameras can be decoded
and displayed on the Video Wall.
Steps:
1. Click Back to Operation Page to go back to the Video Wall Operation interface.
2. Select the screen layout mode for the display window.
3. Click-and-drag the camera from the left-side list to the display window on the video wall.
The video stream from the camera will be decoded and displayed on the Video Wall. Click the

icon ™ and you can get a preview of the video in the lower-right corner of the screen.
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Camera

Search. p
+ _JDWR

= 3 IPCt

+ J NWVR

=) 3 IPC2

@ IPC2_Camerat

+ ' Speed Dome
Layout ~
Third Party Devices ~
PTZ ~

Enter Video Wall Config

Decoder:VGA 1

Default Video Wall

Decoder:VGA 2
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Troubleshooting

Live View

Problem:

® Failed to get the live video of a certain device.

Possible Reasons:

®  Unstable network or the network performance is not good enough.

® The device is offline.

® Too many accesses to the remote device cause the load of the device too high.
® The current user has no permission for live view.

® The version of the client software is below the needed version.

Solutions:

®  Check network status and disable other not in use process on your PC.

® Check the device network status.

® Restart the device or disable other remote access to the device.
® login with the admin user and try again.

® Download the client software of the latest version.
Recording

Problem:

® Local recording and remote recording are confused.

Solutions:

® The local recording in this manual refers to the recording which stores the record files on the
HDDs, SD/SDHC cards of the local device.

® The remote recording refers to the recording action commanded by the client on the remote

device side.

Playback

Problem:

® Failed to download the record files or the downloading speed is too slow.

Possible Reasons:

® Unstable network or the network performance is not good enough.

® The NIC type is not compatible.

® Too many accesses to the remote device

® The current user has no permission for playback.

® The version of the client software is below the needed version.

Solutions:

® Check network status and disable other not in use process on your PC.

® Directly connect the PC running the client to device to check the compatibility of the NIC card.
®  Restart the device or disable other remote access to the device.

® Login with the admin user and try again.
[ ]

Download the client software of the latest version.
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